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Related Manuals

1.Related Manuals

The table below lists the manuals related to this document.

To ensure system safety, make sure to always read and heed the information provided in all
Safety Precautions, Precautions for Safe Use, and Precaution for Correct Use of manuals for
each device which is used in the system.

Cat. No. Model Manual name

W472 CJ2H-CPUSGJ]-EIP CJ-series CJ2 CPU Unit Hardware User's Manual
CJ2H-CPU6[]
CJ2M-CPUI[]

W473 CJ2H-CPUSGJ]-EIP CJ-series CJ2 CPU Unit Software User's Manual
CJ2H-CPU6[]
CJ2M-CPUI[]

W336 CJIW-SCU[J1-V1 CJ Series Serial Communications Units Operation
CJ1IW-SCUJ[]2 Manual

W446 - CX-Programmer Operation Manual

2. Terms and Definitions

Term

Explanation and Definition

PLC link

PLC link is a function which enables an image reader to directly
read/write data to PLC's data memory by connecting the PLC to the
image reader of MARS TOHKEN SOLUTION CO.LTD. through RS232C
or LAN interface.

This eliminates the need to create a communication program, cutting
the time required for programming.




3.Precautions

3. Precautions

1)

)

®3)

(4)

(6)

Understand the specifications of devices which are used in the system. Allow some
margin for ratings and performance. Provide safety measures, such as installing safety
circuit in order to ensure safety and minimize risks of abnormal occurrence.

To ensure system safety, always read and heed the information provided in all Safety
Precautions and Precautions for Safe Use of manuals for each device used in the
system.

The user is encouraged to confirm the standards and regulations that the system must
conform to.

It is prohibited to copy, to reproduce, and to distribute a part or the whole of this
document without the permission of OMRON Corporation.

The information contained in this document is current as of July 2014. It is subject to
change without notice for improvement.

The following notation is used in this document.

f C t. Indicates a potentially hazardous situation which, if not avoided,
aution may result in minor or moderate injury or property damage.

IE' Precautions for Correct Use

Precautions on what to do and what not to do to ensure proper operation and performance.

@ Additional Information

Additional information to read as required.
This information is provided to increase understanding or make operation easier.

Symbol

The triangle symbol indicates precautions (including warnings).
The specific operation is shown in the triangle and explained in text.
This example indicates a general precaution.




4. Overview

4.0verview

This document describes the procedure for connecting Fixed Mount 1D/2D Image Reader
(TFIR-31LAN series) (hereinafter referred to as Image Reader) of MARS TOHKEN
SOLUTION CO.LTD. (hereinafter referred to as MARS TOHKEN SOLUTION) to CJ-series
Programmable Controller + Serial Communications Unit (hereinafter referred to as the PLC) of
OMRON Corporation (hereinafter referred to as OMRON), and the procedure to check their

connection.

Refer to Section 6. Serial Communications Settings and Section 7. Connection Procedure to

understand the setting method and key points to perform PLC link for the Image Reader via

serial communications.

5. Applicable Devices and Device Configuration

I 5.1. Applicable Devices

The applicable devices are as follows:

Manufacturer Name Model
OMRON CJ2 CPU Unit CJ2[J-cPUI[]
OMRON Serial Communications Unit | CJ1IW-SCUJ[J1-V1

CJ1W-SCUJ[)2
MARS TOHKEN | Image Reader TFIR-31LAN
SOLUTION TFIR-31LAN-H

IE' Precautions for Correct Use

As applicable devices above, the devices with the models and versions listed in Section 5.2.

are actually used in this document to describe the procedure for connecting devices and

checking the connection. You cannot use devices with versions lower than the versions listed

in Section 5.2. To use the above devices with versions not listed in Section 5.2. or versions

higher than those listed in Section 5.2., check the differences in the specifications by referring

to the manuals before operating the devices.

@ Additional Information

This document describes the procedure to establish the network connection. It does not

provide information on operation, installation or wiring method which is not related to the

connection procedure. It also does not describe the functionality or operation of the devices.

Contact the device manufacturer.
(MARS TOHKEN SOLUTION CO.LTD. http://www.mars-tohken.co.jp/en/)
This URL is the latest address at the time of this document creation.

Contact each device manufacturer for the latest information.



5.Applicable Devices and Device Configuration

I 5.2. Device Configuration

The hardware components to reproduce the connection procedure of this document are as

follows:

Personal computer

(CX-One,

TECT for TFIR-317x

installed,

OS:Windows 7))

CJ2M-CPU12

USB cable

Serial cable
(RS-232C)

To set the Image Reader, connect the

CJ1W-SCu42

and DC power jac

TFIR-31LAN

Interface cable (with RS-232C

k)

Interface cable to Personal computer. AC adapter
(100 to 240 V)
Manufacturer Name Model Version
OMRON Serial Communications Unit CJ1IW-SCU42 Ver.2.0
OMRON CPU Unit CJ2M-CPU12 Ver.2.0
OMRON Power Supply Unit CJIW-PA202
OMRON CX-One CXONE-AL[][]C-V4 Ver.4.[][]
/AL[][ID-V4
OMRON CX-Programmer (Included in CX-One) Ver.9.51
- Personal computer -
(OS: Windows 7)
- USB cable -
(USB 2.0 type B connector)
- Serial cable (RS-232C) -
MARS Image Reader TFIR-31LAN System version:
TOHKEN M21C-V2.1a
SOLUTION Decode version:
M21A-V2.1a
MARS Interface cable (Included with Image
TOHKEN (with RS-232C and DC power | Reader)
SOLUTION jack)
MARS AC adapter KSAC0500160W1UV-1
TOHKEN (100 to 240 V)(Optional)
SOLUTION
MARS TECT for TFIR-317x - Ver.1.8.0.1
TOHKEN
SOLUTION

IE' Precautions for Correct Use

Update the CX-Programmer to the versions specified in this section or higher versions using
the auto update function.

If a version not specified in this section is used, the procedures described in Section 7. and
subsequent sections may not be applicable. In that case, use the equivalent procedures
described in the CX-Programmer Operation Manual (Cat. No. W446).




5.Applicable Devices and Device Configuration

@ Additional Information

The system configuration in this document uses USB for the connection between the
Personal computer and PLC. For information on how to install the USB driver, refer to A-5

Installing the USB Driver of the CJ-series CJ2 CPU Unit Hardware User's Manual (Cat. No.
W472).

@ Additional Information

Refer to CJ Series Serial Communications Units Operation Manual (Cat. No. W336) for
information on the serial cables (RS-232C).




6.Serial Communications Settings

6. Serial Communications Settings

This section describes specifications such as the serial communications settings, link area
allocation, and wiring cables that are set in this document.

I 6.1. Serial Communications Settings

The serial communications settings are shown below.

6.1.1.
Reader

Communications Settings between the Personal Computer and Image

The setting example below is used to explain the procedure for setting the Image Reader by

using the Personal computer.

Setting item Personal computer Image Reader
Communication port No. COM1 -
Baud rate 9,600bps 9,600 bps (default)
Data bits 8 bits 8 bits (default)
Parity None None (default)
Stop bit 1 bit 1 bit (default)
Flow control None RS/CS control is not performed
(default)
6.1.2. Communications Settings between the Serial Communications Unit and

Image Leader

The setting example below is used to explain the procedure for connecting the Serial
Communication Units to the Image Leader.

Setting item Serial Image Reader
Communications Unit
Unit number 0 -
Communication port Port 2 -
Serial communications mode Host Link -
Data length 8 bits 8 bits (default)
Stop bits 1 bit 1 bit (default)
Parity None None (default)
Transmission rate (Baud rate) 9,600 bps (default) 9,600 bps (default)
1:N/1:1 protocol setting 1:1 protocol -

Interface to output

RS-232C

Connection method

RS-232C, C mode
command(Omron SYSMAC)

Head address of data memory

1000(D1000)

Padding code of data length is
odd

0 (default: NULL:[0x00])

Watch of the trigger area

0:Enable (default)

Wait time of watch from power-on

10 (default: 10sec)

Interval time of watch

10 (default: 10ms)




I 6.2. Allocating the Data Memory

6.Serial Communications Settings

With PLC link, Data Memory for the Image Reader is allocated as shown below.

PLC

D01000

D01001

D01008

D01009

D01010

D01039

(1)—
—(3)

—(2

—(2

Image Reader

Trigger area

Reserved

Area for number of
digits of read data

Read data area

The PLC and Image Reader perform the following operations to the Data Memory above.

(1) PLC writes 1 in the "Trigger area".

(2) After the data such as QR code is read, the Image Reader sets the data to the "Area
for number of digits of read data" and to the "Read data area".
(3) After step(2) is completed, the Image Reader clears the "Trigger area” to zero.

@ Additional Information

For details on allocation of the link area for the Image Reader, contact the device

manufacturer.



I 6.3. Cable Wiring Diagram

6.Serial Communications Settings

For details on wiring cables, refer to Section 3. Installation and Wiring of the CJ Series Serial
Communications Units Operation Manual (Cat. No. W336).

Check the connector configuration and pin assignment before wiring.

m Connector configuration and pin assignment
<OMRON: CJ1W-SCU42>
Applicable connector: D-sub 9 pin

Pin Abbreviation Signal name e

1 FG Shield -

2 D Sand data Output
a RD Receiva data Input

4 RTS (RS) Request to sand Output
5 CTS (CS) Clear to send Input
5] 5V Power supply -

7 DSR (DA) Data sat ready Input

8 DTH (ER}) Diata terminal ready Cutput
g =G Signal ground -
Hood FG Shield -

<MARS TOHKEN SOLUTION: TFIR-31LAN interface cable >

Applicable connector: D-SUB 9 pin

Pin Abbreviation Signal name /10

1 NC Not connected -

2 SD Send data Output
(RS-232C)

3 RD Recieve data Input
(RS-232C)

4 NC Not connected -

5 GND Ground -

6 NC Not connected -

7 CS Clear to send Input
(RS-232C)

8 RS Request to send Output
(RS-232C)

9 NC Not connected -

Shell FG Shield -

=== ]
[
*i'.-
B.;..
1
2]
© (62}
o R
0



6.Serial Communications Settings

m Cable/ Pin assignment

Serial Communications Image Reader
Unit (CJ1W-SCUA42) (TFIR-31LAN)
RS-232C | Signal | Pin No. Pin No. | Signal RS-232C
interface | name name interface
FG 1 o 1 NC
SD 2 2 SD
RD 3 3 RD
RS 4 4 NC
CSs 5 5 GND
5V 6 6 NC
DR 7 7 CSs
ER 8 8 RS
SG 9 9 NC
FG Shell b Shell FG
D-SUB 9 pin D-SUB 9 pin
Cable connector type: Male Cable connector type: Male




7.Connection Procedure

7. Connection Procedure

This section describes the procedure for connecting the Image Reader to the PLC with PLC

link via serial communications.

This document explains the procedures for setting up the PLC and the Image Reader from the

factory default setting. For the initialization, refer to Section 8. Initialization Method.

| 7.1. Work Flow

Take the following steps to connect the Image Reader to the PLC with PLC link via serial

communications.

7.2. Setting Up the MARS TOHKEN
SOLUTION Image Reader

!

| 7.2.1. Cable Connection

|

| 7.2.2. Parameter Settings

!

| 7.3. Setting Up the PLC

|

7.3.1. Hardware Settings

!

7.3.2. Starting the CX-Programmer
and Connecting Online with
the PLC

!

| 7.3.3. Creating the I/O Table

|

| 7.3.4. Parameter Settings

!

7.4. Checking the Serial
Communications

1
7.4.1. Checking the Connection
Status
|

7.4.2 Checking the Data that are
Sent and Received

Set up the MARS TOHKEN SOLUTION Image Reader.

Connect cables to the Image Reader.
Set the parameters for the Image Reader.
Set up the PLC.

Set the hardware switches on the Serial
Communications Unit and connect the cables.

Start the CX-Programmer and connect online with the
PLC.

Create the 1/O table for the PLC.
Set the parameters for the Serial Communications Unit.

Confirm that PLC link via serial communications is
performed normally.

Check the connection status.

Confirm that the correct data are sent and received.

10



7.Connection Procedure

I 7.2. Setting Up the MARS TOHKEN SOLUTION Image Reader
Set up the MARS TOHKEN SOLUTION Image Reader.

7.2.1. Cable Connection
Connect cables to the Image Reader.

IE' Precautions for Correct Use

Make sure that the power supply is OFF when you perform the setting up.

1 Make sure that the power supply
to the Image Reader is OFF.

*If the power supply is turned
ON, settings may not be
applicable as described in the
following procedure.

2 Check the position of the LAN LAN connector

connector and Interface cable |:| Lo
connector on the Image Reader. Interface cable {:} = 1;;;1:”‘

SN T o000
connector B 4= 1o

L T = e

(Image Reader)

3 Connect the AC adapter to the iy 0
Interface cable. Interface cable .;' E E

Connect the Image Reader to = =4 TN
<5 e y AN 00

B - T

the Personal computer with the w] — e
interface cable.

(Personal computer) AC adapter (Image Reader)

4 Turn ON the Image Reader and
Personal computer.

11



7.Connection Procedure

7.2.2. Parameter Settings

Set the parameters for the Image Reader.
The "TECT for TFIR-317x" software is used to set parameters.

@ Additional Information

For details on how to install TECT for TFIR-317x, contact the device manufacturer.

1 Start the TECT for TFIR-317x
from the Personal computer.

2 The TECT for TFIR-317x starts
as shown on the right.

After the parameter is complete
to read, "[Read settings] is
required" disappears from the
window enclosed in red as
shown on the right.

Once it disappears, perform
step 12 and subsequent steps.

\ w3 | o | w [ v v ]|w .
i w3 0w 1w ¢ am | e

] = [ T T e T e L e e

S ofl[7 | @ o M 1 & | e o B

*If a setting other than described
in 6.1.1. Communications
Settings between the Personal
Computer and Image Reader is
made to the Personal
computer, the COM1
[9600,n,8,1] Dialog Box is
displayed.

Confirm that there is no
problem and click the OK
Button. Perform step 3 and
subsequent steps.

12



7.Connection Procedure

3

Select Change
Communication settings from
the Communication Menu.

{3 TECT for TFIR-317x, TFIR-31LAN - Setha-

File | Communication | Language Help

Terminal

Change Communication settings

The Change Communication
settings Dialog Box is displayed.
Select RS-232C Option and
click the Next Button.

Communication Settings

The communication settings of the scanner can be
modified from the designated window.

It iz useful because the communication settings of
the scanner can be changed after changing the
communication settings of the application software.

To start configuration , please select the type of
interface and then click [Next

+ R5-232C
T

)

i Cancel |

‘ Nesct{ M) > |

A message "Settings of the
application" appears in the
Change Communication
settings Dialog Box.

Select the communication port
No. that the Image Leader is
connected (Com2 in this
example), and then click the
Button.

Each value in Baud, Frame, and
Flow Control Fields for the
Image Leader is automatically
retrieved.

*If there are multiple serial ports
on the Personal computer,
display the Windows Device
Manager. Then select the
same port as the
communications port No. that
the Image Leader is connected
under Ports (COM & LPT)
(COM2 in this example).

*To display the Device Manager,
right-click My Computer and
select Properties - Device
Manager.

Settings of the application

If the interface 1z o s pieaze manually select
" COM number. Clicking the circle will get baud rate
and data frame structure automatically.

If the interface is LAN, please click [AUTO] then
TECT will detect the device automatically.

When finish, please click [Me:

Port Baud
=) JCom2 vI 9600 -

Frame

DataBits |5 -
ParityBit |None +
StopBits

Cancel | < Back(B) | Mexct{M) > |

" Xon/Xoff
 RTS
" Xon/RTS

= Device Manager
File  Action

&= @ E HE ® B%S

View Help

475 Ports (COM & LPT)
P Communications Port (COM2)

Processors

a

anagement Technelogy - SOL (COM3)

-

13



7.Connection Procedure

6 Confirm that the button

changes to the blue button®,
and click the Next Button.

*If the red button @ is
displayed, perform step 5 after
checking the communication
port No. that the Image Leader
is connected

&Change Communication set_

Settings of the application

If the interface is RS-232C, please manually select
GOM number. Glicking the circle will get baud rate
and data frame structure autamatically.

¥ the interface iz LAN, please click [AUTO] then
TECT will detect the device automatically

‘ivhen finizh, pleaze click [Next]
rt

Baud
‘ ODCOmQ || Joson -]
Frame Flow Control
DataBits m f+ Mon
ParityBit [None -] ¥ LETRG
i  RTS
StopBits 4 4  XonRTS

Cancel | < Back(B) W Nextl]i 3

7 A message "Baud of the
scanner” appears in the Change
Communication settings Dialog
Box.

Confirm that the setting is as
follows:

* baud: 9600(bps)

Click the Next Button.

&Change Communication settings

Baud of the scanner

Configuration of the scanner's baud rate
Please select baud rate and then click [Mext]

baud
1200 | 2400 | 480 G600 | J19.2K | 384K | 576K | 115K
N
Gancel < Back(B} Finizh{F}

o) A message "Frame of the
scanner” appears in the Change
Communication settings Dialog
Box.

Confirm that the setting is as
follows:

« frame: 8N1

Click the Next Button.

&Change Communication settings

Frame of the scanner

Configuration of The scanners frame structure
Please select frame structure and then click [Mext]

frame

01 | W02 | 7E1 7E an1f) BN2 | 801 | 802 | 2E1 2E2

\——

Cancel { Back(B)

Finizh{E)

9 A message "Network setting"
appears in the Change
Communication settings Dialog
Box. Click the Next Button.

*No need to set Network setting.

&Change Communication settings

etwork setting

Please conzult network adminstrator before
network configuration

The change of network settings will be effective
after [WSETS] command to zave the settings and
then restart the scanner.

" Network zetting is returned to default settings.

@+ The netwark setting is changed.

IP address |192.168.250. 2
Subnet mask |235.255.235. 0

Default gateway | 19¢.148.209.254
Port # of TCP protocol | 27110

TCP Client
TCP Server

Cancel | < Back(E) Finish(E |

14



7.Connection Procedure

10

A message "Settings are
modified" appears in the
Change Communication
settings Dialog Box. Click the
Finish Button to close the
Change Communication
settings Dialog Box.

&Change Communication settin

ettings are modified

The communication settines are modified

11

"[Read settings] is required"
appears as shown on the right.

Oy
Click the Read Settings ﬂ
Button.

"Read Settings" is displayed in a
grayout state while the setting is
being read.

After the parameters are
correctly loaded, "[Read
settings] is required" disappears
from the window enclosed in red
as shown on the right.

e Cybe Fuftar ICapturng Pring
P

Mirrar Sy by

[ 3] 8y &)

Dbl ey [ |
I -
Bk Lot )

(R 0 -

Camars wttings

brage pegroceesrg )

T o 53] g

Ednte riat [ T3] —

||| TFIR-31 Lati = Satring barary

Eo‘w

[Hood sottings] is required

Te rcesed, st ecvcete ot setirasl afer erfnrin
ity
Bortipacicn f ctmmsicalon stings

Fiare b Famis camin ot Commniaion

ST b TR o
Bl Commusicacien Larguage  Hein
Image capture & Adjstmont 1

Tysle Buffor (Capturing timing!
Bk | 62, sl T3]

Tatla of satings (ozarnar)
Tathns mumscn| 525

e casen| 03]

TRF=01L8H = Sattirg lmry

=T

Lubigls bbel / Preset function @)
G Cerred
Fration| s | TamiE

Mrer Symoal

GREEEIE)

W aa || W | W | 8 k[ | ek | ®
: ] L]
z " 3 [ L 1 ® I3 (TT1TY ]
T o ¥ u W 1 7 -1 FLLORN []
W o1 | 1 o " : W | b T 8
Wm0 w | w1 s wew | 2
B " s 8 ] [
DTN il [ 1 . sannn [
[T e [ 0 | e i iy | e [ s e o i
[ ] w | w R 0
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7.Connection Procedure

12 SeIeCt the DeCOder Settlngs Image capture & Adjustment i( Decoder settings i
Tab Page. The Communication Wobgko oa|1op| el oua| op|  Centerpsrion Code39
1 i 1 &+ Enab
and Decoding (Basic options) Desode time N Captre e, N Gormer pestion [N
i H Reading Digits l_
FIeldS are dlSplayed. Total time MO Symbol type MO Mirror status ,_
. . Edit Digit:
Conflrm that the fo”OWlng Quiality status NO Gorfrast status : Ig‘éheck
settings are made. Buzzer [ vEs _
. ) ) Symhol type Add diagnosis data RULL
In the Communication Field: Decoding)Bssic optloms fransmt
= Flow Control (Handshake) : e z
. = — = Tlmeaut TeSt e
232 is not selected. ' y ) Co
A Flow Control 232 | TGP = iiialiin @ JAN/EAN /U
(When Handshake is not (rsiele) @ rori
erformed, RS/CS control is e
P A SN
not performed)
In the Decoding (Basic options)
Field:
* Interface to output: 232C
Check the settings and click the
Hide Button of Advanced
Options (PLC-LINK).
13 The button of Advanced Options |
(PLC-LINK) changes to Show L e
. JAN  EAN | UPC Cadabar M
from H|de @ FOFT | ManiCode | @ CR-Code
" - Qrus | @eowm | @uss
Communication (Advanced @ o | @ compones | @ pencow

options)" appears.

Sat the head address of data memary [ |

ot th parkfing code of et lerath s okt [0 Lo 15 £200 |

Watch af the tricoer area [ Oisstie

TR —
Writa Settings teh from ¢
(=53 2
el 53

Eat tihe interal time of weich

14

Make the following settings in
the PLC-LINK Field.

= Connection method:
RS-232C, C mode
command(Omron SYSMAC).

- Set the head address of data
memory: 1000

+ Set the padding code of data
length is odd: 0:NUL][0OQ]

- Watch of the trigger area:
0: Enable

- Set the wait time of watch from
power-on: 10 sec

« Set the interval time of watch:
10 ms

Communication (Advanced options)

Citrl| codes conversion MO

PLC-LINK

Connection method Mot use LAN

‘I R5-232C

G protocal C mode command MO pru:utu:u:u:ul k' command
Qnd 3G frame £ 1G frame
{MELSEC Q/L) I:MELSEO Fx) (KEYEMNGE K\
Set the remote port and ip
informatin of the FLC 192.168. 0 .10 ‘ 9600
Zet the endianhess 0:LITTLE 1: BlG
IEffective at FLGWMODE=1] | (MELSEG Q/L) (KEYEMNGE K\

(Left half of the PLC-LINK Field)

Set the head address of data memary | 1000
1: 5P [20]

0: Enable %

Set the walt time of watch from power-on|| 10 -] fec

Zet the interval time of watch 10 Jns

(Right half of the PLC—L%;)

Set the padding code of data length iz addf] 0: HUL[0O]

Watch of the trizzer area

il

[«

»

L

16



7.Connection Procedure

] ; ;
15 Click the Write Settings ﬂ Write Settings

Button. 2y EJ.};
[0 BNG

"Write Settings” is displayed in a
grayout state while the setting is
being written.

@grite Settin@

After the parameter is written, R =R
0

+

O

"Write Settings" appears.

16 Click the Save to imager & Difilte ©ariin:
Button to save the settings to =23 E—EJR;
non-volatile memory in the S0 SN
Image Reader.

*Without clicking the Save to

imager & Button, if the | E h“\
Ima_ge _Reader is t_urned ON ;Save = imager;
again, it starts up in the

previous settings.
S ——— )

Select Exit from the File Menu i
TECT for TFIR-317x%, TFIR-31
17 §exitthe TECT for TFIR-317x. | = - -

File | Communication Languacg
Restoration Point
Exit

17



7.Connection Procedure

| 7.3 setting Up the PLC
Set up the PLC.

7.3.1. Hardware Settings
Set the hardware switches on the Serial Communications Unit and connect the cables.

El Precautions for Correct Use

Make sure that the power supply is OFF when you perform the setting up.

1 Make sure that the power supply
to the PLC is OFF.

*If the power supply is turned
ON, settings may not be
applicable as described in the
following procedures.

2 Check the position of the B — _
hardware switches on the front g2 e RS ML Indicators
side of the Serial '

. . . Terminating
Communications Unit by

resistance switch

preferring to the right figure. 7= Unit number
switch

*This setting is required to use i;v“ﬁ'éﬁm'\”ire
Port 2 of the Serial  Port1-

Communications Unit. RS-422A/485

terminal-block
connector

+ Port 2:
RS-232C

3 Set the Unit number switch to 0.

*The unit number is setto 0 as
the factory default setting.

4 Connect the Serial | Personal computer | PLC Serial Communications Unit
Communications Unit to the

PLC as shown on the right.
Connect the Interface cable for
the Image Leader to the Serial

€= End Cover

K . . i USB cable
Communications Unit with the
H Image Reader
Serial cable. Interface cable 9
Connect ;he Personal computer Power Supply Unit v
to PLC with a USB cable.

A

Serial cable

5 Turn ON the power supply to the
PLC.

18



7.Connection Procedure

7.3.2. Starting the CX-Programmer and Connecting Online with the PLC
Start the CX-Programmer and connect online with the PLC.
Install the CX-One and USB driver in the Personal computer beforehand.

1 Start the CX-Programmer.

2 The CX-Programmer starts.

Do MBS O |[ALS B LN RARIRSS DEE
nac =Bt i | — 0P EEELK|[REn|usnn|E BE
*If a Conﬁrmation dlalog for an 5 N_ i TERLBLE RSB N ahranmMEeey |omds

access right is displayed at
start, execute a selection to
start.

3 Select Auto Online - Direct

. I PLC | Tools Help
Online from the PLC Menu.

Auto Online ¥ Qirect Online

] &%, CP1L-Ethernet Online
LR | G 8E S @, EtherNet/IP Node Online
4 The Direct Online Dialog Box is .. )
displayed. o ———,
Select the USB connection Goes online automatically.
Option for Connection Type. Select connection type and press [Connect] button.

Click the Connect Button.

—Connection Type

e Serial connection
(also when using LUSB-Serial conversion cable)

Sernial port of PC

[com =]

¥ Connects at baud rate 115,200 bps

I {* UUSB connection

nnection will automatically be made to the PLC connected directhy to
he PC wvia USE cable.
Please select " Seral connection™" when using USE-Serial conversion
ble.
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7.Connection Procedure

5 The dialog box on the right is
displayed. Check the contents

. Do you wish to transfer program from the PLC after onlined automatically?
and click the No Button.

[~ Transfer 10 table and Special Unit Setup

6 The dialog box on the right is [ o Online(Searching)
displayed, and the

CX-Programmer and the PLC
are automatically connected.

PLE: F-.IZJ'CF'HNSJ Series

Commurication |LISE
Settings:

Protocal: |LISE

7 Confirm that the 55 - CX-Programmer - [[327%F] - FRPLC LA 17 5h1. e [55° -] 5]
[F? 774ME) #E£(E) BR(W) BA(Q) PLCC) 7'09°34(R) ¥3ab-3ay(S) ¥-MI) MUEI(W) A (H) [=[=]x]
CX-Programmer and the PLC DEE|R SR 4 B[R0 u=5 0% (8)% %52
are normally connected online. aoQa [HekEmEREe R rvew ) —osFaEL Kk |[E ¢

*The & icon is pressed down
during online connection.

@ Additional Information

If an online connection cannot be made to the PLC, check the cable connection.

Or, return to step 2, check the settings and repeat each step.

Refer to Connecting Directly to a CJ2 CPU Unit Using a USB Cable in Chapter 3
Communications in PART 3:CX-Server Runtime of the CX-Programmer Operation Manual
(Cat. No. W446) for detalils.

@ Additional Information

The dialog boxes explained in the following procedures may not be displayed depending on
the environmental setting of CX-Programmer.

For details on the environmental setting, refer to Options and Preferences in Chapter 3
Project Reference in PART 1:CX-Programmer of the CX-Programmer Operation Manual
(Cat. No. W446). This document explains the setting procedure when the Confirm all
operations affecting the PLC Check Box is selected.
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7.3.3. Creating the I/O Table

Create the I/O table for the PLC.

7.Connection Procedure

1

If the operating mode of the PLC
is Run Mode or Monitor Mode,
change it to Program Mode by
following the steps below.

(1) Select Operating Mode -
Program from the PLC
Menu of the
CX-Programmer.

(2) The dialog box on the right is
displayed. Confirm that
there is no problem and click
the Yes Button.

*Refer to Additional Information
on the previous page for the
settings concerning the dialog
display.

(3) Confirm that Stop/Program
Mode is displayed on the
right of the PLC model in the
Project Tree.

Ix]

E--% MewProject

£ @@ NewPLCLICI2MIEn ModD
Pmem . T

File Edit View Insert Prog Simulati Tools  Wind Help

DS W[k & [[[& Work Online Ctrl+W

Auto Online
a XK QR |i[g
Operating Mode
’E,ﬁﬁ m Manitor 0 Debug Ctrl+2

'@ Monitor  Ctrl+3
T Run Ctrl+4

E--% MNewProject | =5

I ..... % Symbols Memeory Allocation L4

B @@ NewbPLCL[C2M Program Check Options...
L8 Data Types Program Assignments

& Make sure that there aren't any problems if the PLC is stopped.
! Do you wish to switch the PLC into program mode?

El--%’ MewProject
=-f§ NewPLC1[CJ2M]Gtop/Program Mode

----- "™ Data Types

----- = Symbols
2 Select Edit - I/O Table and Unit  |[#e et view msen Program _ Simulation Tools Windew _Help
Setup from the PLC Menu of the  |||D & B | & || etk onine arw Lo [[an%m®
CX-Programmer. LY ET v, Pl —osEEL K|
’EE@E@ Manitor - ] i

The PLC 10 Table Window is
displayed.

E-% NewProject ¥ Compile All PLC Programs F7
-F@ NewPLCLICIZM Pregram Check Options...
™% Data Types Program Assignments

-2 Symbeols Memory Allecation
- 10 Tabl
ablean Transfer
[ Settings
~[B Memory car Partial Transfer
[ Errorlog Protection
(&) PLC Clock Clear All Memory Areas
4 Memory -
m Information
H (a NewProc Change Model ]IQ Table and Unit Setup
i Change Communication Settings [l Settings
IF Function Bl Ll g g

M Card
Uy Data Trace.. | =1} “E""‘O"Y:ﬂ’

e

" @7 PLCIO Table - NewPLC]

File Edit View Options Help

B SR+ &= 3|2 ek

--h Inner Board
-4 [0000] Main Rack
14, [0000] Rack 01
] 4agy [0000] Rack 02
-4, [0000] Rack 03
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3

Select Create from the Options
Menu of the PLC 10 Table
Window.

The dialog box on the right is
displayed. Confirm that there is
no problem and click the Yes
Button.

The dialog box on the right is
displayed. Confirm that there is
no problem and click the Yes
Button.

7.Connection Procedure

PLC IO Table -
File Edit View | Options | Help

The Transfer from PLC Dialog
Box is displayed. Select the 1/0O
Table Check Box and the SIO
Unit Parameters Check Box,
and click the Transfer Button.

When the transfer is completed,
the Transfer Results Dialog Box
is displayed.

Confirm that the transfer was
normally executed by referring
to the message in the dialog
box.

When the I/O table is created
normally, the dialog box displays
as follows:

Transfer Success: 1 Unit
Transfer Unsuccessful: 0 Unit

Click the OK Button.

u.;:"%l %l@l.ﬁm Transfer to PLC

------ & CzM-CcPUi Transfer from the PLC
T -

"Q Inner Boare Compare with PLC
h [00O] Mai Create

G-ty [0000] Rac

-4 [0000] Rac Verify

Select the transfer target data and press the [Transfer]
button.
Comment irformation is deleted if 10 Table is transfemed.

v 10 Table

¥ SI0 Unit Parameters

Transfeming...

ENNENNENNER

<I0 Table=
Transfer Success

<Special Units settings>
CPU Bus UnitD0: Transfer Success

Transfer Success:1 Unit  Transfer Unsuccessful:0 Unit
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7.3.4. Parameter Settings

7.Connection Procedure

Set the parameters for the Serial Communications Unit.

1 Double-click [0000] Main Rack
on the PLC IO Table Window to

expand the tree.

Eile Edit View Options Help

& slRlw| lme| o7 wElelE] |
------ 'I CZM-CPU12
glnnerﬂoard

BV 60001 v Rk

s 00 [1500] C.IlW SCU42(5erial Communication Unit) (Unit: 0)
sl 01 [0000] Empty Slot

2 Right-click
00[1500]CJ1W-SCU42 and
select the Unit Setup.

File Edit View Options Help

& sl ¥|m(e 32| Bld=lx o
= C2M-CPU12

+-dggy Inner Board

- jj [0000] Main Rack

'I 00 [1500] CAW-5CU42(Senal Communication Unit) (Unit : 0)

01 [0 Add Unit
Change / Confirm Units
Change Unit Mo

Unit Comment

06 [00 SYSMAC BUS Master »

ﬁiﬁﬂﬁﬁiﬁﬂ
]
Ln
El

09 [0d Save Parameters

3 The View Parameters Dialog

Box is displayed. Select Port2:

Host Link Settings for
Displayed Parameter.

*This setting is required to use
Port 2 of the Serial
Communications Unit.

Set Defaults |

CIIW-5CU42 [View Parameters]

Displayed Parameter |All Parameters

All Parameters
Port1 Settings

Iter Port2 Settings
:Port settings  |Port1: Host Link Settings
2 " Port1: NT Link Settings
: SENACOmIm Port1: Mo-Protocol Settings
:Datalength  |poi1: Protocel macro Settings
: Stop bits Port1: Seral Gateway Settings
~Parity Port1: Loopbacktest Settings

: Port1: MODEUS-RTU Slave Settings
BEE TN O Port2: Host Link Settings
cSenddelay  |Port2: NT Link Settings
- Send delay (udPort2: No-Protocol Settings ms
N PortZ: Protocol macro Settings
- CTS control Port2: Serial Gateway Settings
: 1:NM:1 protocPort2: Loopback-test Settings
- Host Link com|Port2: MODBUS-RTU Slave Settings
: Host Link unit number 0
: No-Protocol Start code 0
: No-Protocol End code 0

<Default >Default (3600bps)

<Address=Word:D30001, Bit:0-3
<Type:xList

TrangferlUntto PC] | TransfedPCto Unt] |  Compare |
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7.Connection Procedure

The setting items of the Port 2:
Host Link Settings are listed as

4

CIIW-3CU42 [View Paramete|

shown in the right figure.
Displayed Parameter hd
ltermn Set Value Unit
Pon2: Port settings Defaults
Port2: Serial communications mode Host Link({default)
Por2: Data length 7 bits
Portz: Stop bits 2 bits
Por2: Parity Even
Port2: Baud rate Default{9600bps)
Por2: Send delay Default (0 ms)
Port2: Send delay (user-specified) 0 ms
Port2: CTS control Mo
Port2: 1:N/M1:1 protocol setting 1:M protocol
Port2: Host Link compatible device mo | DefaultiMode A)
Port2: Host Link unit number 0
5 Select User settings for Port * CIIW-SCUA42 [View Parameters] \
settlngs.
Displayed PEIIEII'I'IE‘tEFIPortZ: Host Link Settings ;I
Item SetValue Unit

Port2: Port settings =~
Port2: Serial communications mode Defaults
Portz2: Data length er Sefng
Por2: Stop bits 2 bits
Port2: Parity Even
Port2: Baud rate Default(9600bps)
Por2: Send delay Default (0 ms)
Portz: Send delay (user-specified) 0 ms
Port2: CTS control Mo
Port2: 1:Mi1:1 protocol setting 1:M protocol
Port2: Host Link compatible device mo | DefaultiMode A)
Port2: Host Link unit number 0

Set the following parameters in
the same way as step 5.

+ Serial communications mode:

Host Link(default)

+ Data length: 8 bits

+ Stop bits: 1hbit

» Parity: None

* Baud rate: Default (9600 bps)
+ 1:N/1:1 protocol setting:

1:1 protocol

6

*Use the default settings for
other parameters.

Click the Transfer [PC to Unit]
Button.

CJIW-5CU42 [View Parameters

Displayed Parameter |Port2: Host Link Settings

Itermn

SetValue

PortZ; Port settings

User settings

Port2: Serial communications mode

Host Link{default)

Paort2: Data length

2 bits

Port2: Stop bits

1 bit

Port2; Parity

Mone

Port2: Baud rate

Default(9600bps)

PortZ: Send delay

DETaun [ =)

Port2: Send delay (user-specified)

0

Port2: CTS control

Mo

Paort2: 1:MM:1 protocol setting

1:1 protocol

Port2: Host Link compatible device mo

Default(Mode A)

Port2: Host Link unit number

0

<Default >Defautts

<Address>Word:D30010, Bit:15
<TypexList

Transfer{Unit to PC] | | Transfer[PC to Unit Compare

Restart |

Set Defaults |
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7.Connection Procedure

7 The dialog box on the right is
displayed. Confirm that there is
no problem and click the Yes

. Downloads parameters to the unit.

Button. LE. Are you sure you want to continue?

[Transfeming parameters (PC to Unit)

When the transfer is completed,
the dialog box on the right is
displayed. Click the Close

Button. {__WQ

I ransfer successful
o) A dialog box on the right is - '

displayed. Check the contents Edit Parameters
and click the Yes Button.

@>% Itis necessary to restart the unit to transfer the setting effectively.
V' Do youwish to restart the unit?

| Yes || Ne I |

The Select Port Dialog Box is
displayed. Select All ports and

click the OK Button. Select a port to restart from the list below

9 The dialog box on the right is
displayed. Check the contents
and click the OK Button.
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7.Connection Procedure

Click the Compare Button on
the View Parameters Dialog
Box.

10

" CILW-5CU42 [View Para

Displayed Parameter |Port2: Host Link Settings

Item

SetValue

: Port settings

User settings

: Serial communications mode

Host Link{default)

- Data length

8 bits

- Stop bits

1 bit

- Parity

Mone

: Baud rate

Default(9600bps)

- Send delay

Default (0 ms)

. Send delay (user-specified)

0

: CTS control

Mo

- 1:Mi1:1 protocol setting

1:1 protocol

- Host Link compatible device mo

Default(Mode A)

: Host Link unit number

0

-

«Default >Defaults

<Type>List

<Address>Word:D30010, Bit:15

Transfer{Unit to PC] | | TransferiPCto Uni] || Compare ||

Set Defaults |

After confirming that a message
"Compare successful" is
displayed in the dialog box on
the right, click the Close Button.

11

Click the OK Button on the View
Parameters Dialog Box.

12

" CILW-5CU42 [View Para

Displayed F'Euan'leterlF‘ortZ: Host Link Settings

ltem

SetValue

Read Value (Compare

. Port settings

User settings

User settings

: Serial communications mode

Host Link{default)

Host Link{default)

- Data length

8 bits

8 bits

: Stop bits

1 bit

1 bit

- Parity

MNone

MNone

: Baud rate

Default(3600bps)

Default(2600bps)

. Send delay

Default (0 ms)

Default (0 ms)

: Send delay (user-specified)

0

0

: CTS control

Mo

Mo

- 1:Mi1:1 protocol setting

1:1 protocol

1:1 protocol

- Host Link compatible device mo

DefaultiMode A)

DefaultiMode A)

:Host Link unit number

0

0

<Default >Defautts

<Type=List

<Address>Word:D30010, Bit:15

Transfer[Unit to PC] | Transfer[PCto Unit]

Set Defaults |




7.Connection Procedure

I 7.4. Checking the Serial Communications
Confirm that PLC link via serial communications is performed normally for the Image Reader.

7.4.1. Checking the Connection Status
Check the connection status.

1 Confirm that PLC link is normally in
operation by checking the LED
indicators on the Serial =]

Communications Unit. SCU42 o1 ros TR
a [ a a a ﬂ

=] [= [=] =]
o ) ROY ERH SD2 ROD2
* The LED indicators in normal

status on the Serial TEDF'F"'F'E
Communications Unit are as WIRE
follows: 23
[RUNT: Lit green (Serial Communications Unit)
[RDY]: Not lit

[ERC]: Not lit

[ERH]: Not lit

[SD1]: Not lit

[SD2]: Not lit

[TER1]: Not lit

[SD2]: Flashing yellow

[RD2]: Flashing yellow
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7.Connection Procedure

7.4.2. Checking the Data that are Sent and Received

Confirm that the correct data are sent and received.

Watch window.

Confirm safety sufficiently before monitoring power flow and present value
status in the Ladder Section window or before monitoring present values in the

If force-set/reset or set/reset operations are incorrectly performed by pressing
short-cut keys, the devices connected to Output Units may malfunction,
regardless of the operating mode of the CPU Unit.

1 Confirm that the PLC is in Program
Mode.

*If the PLC is not in the Program
mode, change to Program mode
by referring to step 1 of 7.3.3.
Creating the I/O Table.

=l

E--% MewProject
= MewPLC1[CI20]] Stop/Program Mede

----- B® Data Types

2 Select Edit - Memory from the PLC
Menu.

Insert Program  Simulation Tools Window Help

33 & Work Online Ctrl+W D 7 N R 8, | @y | &g
Auto Online 4
S —OogEE-L K
Operating Mode 4
ﬁ 81 Maniter 4
- 1
{#¥ Compile All PLC Programs z | T
2M] Ma Program Check Options... prt.Setl
e Program Asygmfnents B
Memaory Allocation L4 REEFGIIT | So00aT
i Local Commu
and Uni TrEnshr 3 cationsinFror
- a
card Partial Transfer 4
Protection 4
k Clear All Memory Areas
. Edit 4 Information
:rogram Change Model §7 1/Q Table and Unit Setup
mbols Change Communication Settings Settings

art_Set s Data Trace... [=] Memory Card

M ry Cassette/DM
pe.n_Prc Time Chart Monitoring... Emci" g E E_
1gin_Pre Reset CP1L Built-in Ethernet Port
Force 3
ind_Pro , [B Error Log
zceive_F =

Expansion Instructions

| ||

l41 Clock

rgout_Processing
ose Processing

k
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7.Connection Procedure

3

Double-click D from the list in the
PLC Memory Window that is
displayed.

LC - EEE
File Edit View Grid Online Window Help

B SR &=
2| @(n|elwfE o s B 2|aQ
—————————— I

D

Start Address: | 0 On it
ChangeOrder | Farcelff

a9 Bl B | B | B2

fl czm-cpui2

Selialue

Forceln ForceCanc

+0 +1 +2 +3 +4 +5 +5 +T +8 +9 -
D00000 [
D00010
000020
DO00030
nnn4n hTa
J: Ond0ff, T: ChangeOrder

Cul+J): ForceOn,  Ctl+K: ForceOff, Chl+L: ForceCancel

i G Memory | E» Address I

Ready |DU

[cizm - cpuiz |Monitor [

oM

4

Select Display - Hexadecimal from
the View Menu.

[View] Grid  Online  Window Help

Always On Top

| 28] Bl R

Toolbars...
v Status Bar
v' | Data Area WorkSpace

=

Display 4 Binary

ZoomIn Ctrl+PgDn Bma.r}r Coded Decimal
Zoom Qut Ctrl-PgUp Decimal

100% Signed Decirnal

Floating point

Resize Columns *  Hexadecimal

Select Monitor from the Online
Menu.

Preferences... Text
[inine Window Help
Transfer To PLC...

Transfer Erom PLC...
Compare With PLC...

Monitor

The Monitor Memory Areas Dialog
Box is displayed. Confirm that the D
Check Box is selected and click the
Monitor Button.

| |
Cancel |

Monitor I

Enter 1000 in the Start Address
Field in the D Window.

Confirm that the start address
changes to D01000.

Start :\ddress:I

“ D =N Nol /)

SetValue

1000 On Off

ChangeDrder Farceln Farcedff ForceCanc

+0 +1 +2 +3 +4 +5 +6 + +8 +9

»

D01000) 0000 | 0000 | 0000 | 0000 | 0000 | OOOO | OOOO | 00OO | 0000 | 0000

0000 | 0000 | 0000 | 0000 | 0000 | 0000 | 0000 | 0000 | 0000 | 0000

001020 | 0000 | 0000 | 0000 | 0000 | 0000 | 0000 | 0000 | 0000 | 0000 | 0000

001030 | 0000 | 0000 | 0000 | 0000 | 0000 | 0000 | 0000 | 0000 | 0000 | 0000

D01040 | 0000 | 0OOO | 0OOO | 0OOO | 0OOO | 0OCO | 0OOO | 0OOO | OOOO |OOOO | -

Jo Ond0Off,  T: ChangeOrder
Chrlw): ForceOn,  Chl+k: ForceOff,

Cirl+L: ForceCancel
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7.Connection Procedure

o] Click the Set Value Button.

Start Address:| 1001 on | of | setvaie ||
Ehange[lrderl Farzeln I Farcelf I FurceEancl

The Set Value: Hexadecimal Dialog
Box is displayed.

. Set Value: Hexadecl

—Range
Oto FFFF

o] Install the Image Reader so that it
can read a QR code.

10 Enter 1 in the Value Field.

Click the OK Button.

Range
Oto FFFF

The value of D01000 changes to T T

0001. D01 00 00 | o000 | oooo
OOi 010 | ooog | 0000 | 0000 | gooa

11 The Image Reader reads the QR

code.
12 The value of D01000 changes to
0000. S D =5 EoRF==
The number of digits of read data is = Stat Address:| 1000 on | o | sevaue |
stored in D01009. The read data is ChangeDldell Forceln I Forcelff | ForceCanc I

stored in D01010 onward.

y +1 +2 +3 + +5 +5 +7 +5 +9 -
D0o41000\] 0000 2 000000000000 | 0000 | 0000 | 0000 | 0000 | 0000CLO0DA |:|
*In the rlght fIgUI’e, the fO||OWIng 0101 2 | 4344 | 4531 | 3233 | 3435 00 | 0000 | 0000 | 0000 | OOOO

. 001020 | OUTT T Ot Bt 0000 | 0000 | 0000 | 0OOO | OO0
data is read.
* Number of digits of read data:
000A(10: decimal)
* Read data: 4142 4344 4531 3233
3435('AB CD E1 23 45)
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8. Initialization Method

This document explains the setting procedure from the factory default setting.
Some settings may not be applicable as described in this document unless you use the

devices with the factory default setting.

I 8.1. Initializing the PLC

8.Initialization Method

To initialize the settings of the PLC, it is necessary to initialize the CPU Unit and Serial
Communications Unit. Change the PLC to PROGRAM mode before the initialization.

8.1.1. Serial Communications Unit

(1) Select Edit - /0O Table and Unit Setup from the PLC Menu of the CX-Programmer.
On the PLC 10 Table Dialog Box, right-click the Serial Communications Unit and select

Unit Setup from the menu.

----- & C2m-cPu12
[+-4agy Inner Board
£-&§ [0000] Main Rack

..... ] w [lm'l Ll TV ol W e o e e et el P N PN N S
..... 5 01 (0000 Add Unit
----- 7’ 02 [0000 Change / Confirm Units
""" % 03 (0000 Change Unit No
""" E: g: {gggg Unit Comment
..... g
_____ % 06 [0000 SYSMAC BUS Master
""" % 07 [0000 Unit Setup
----- 5 08 [0000
d na mann Save Parameters

(2) On the View Parameters Dialog Box, click the Set Defaults Button, and click the Transfer

(PCto

Unit) Button.

F ™

Displayed Parameter |AII Parameters

Item

Set Value

Fort1:

Port settings

Defaults

Fort1:

Serial communications mode

Host Link(default)

Fort1:

Data length

7 bits

Port1

: Stop bits

2 bits

Fort1:

Parity

Even

Fort1:

Baud rate

Default{9600bps)

Port1

- Send delay

Default (0 ms)

Fort1:

Send delay (user-specified)

0

Fort1:

CTS control

Mo

Port1

2 1:NM:1 protocol setting

1:M protocal

Fort1:

Host Link compatible device mo

DefaultiMode A)

Fort1:

Host Link unit number

0

Fort1:

Mo-Protocol Start code

0

Help

Transfer{Unit to PC] || _mn;fer L to Unt |

Fort1:

Mo-Protocol End code

0
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8.Initialization Method

8.1.2. CPU Unit
To initialize the settings of the CPU Unit, select Clear All Memory Areas from the PLC

Menu of the CX-Programmer. On the Confirm All Memory Area Clear Dialog Box, select
the Initialize Option and click the OK Button.

Confirm All Memory Area Clea

—Clear all Memary Areas

This function will initialize the following target area of
PLC. After checking the target area, select ‘Intialize”
and press O,

PLC Mame |NewF‘LC1

PLC Type FJEI'H'I-CF‘U'IE

Target Area Program Area

100 Area
Parameter Area
-PLC Settings fArea
-Perpheral Device Area
-0 Table Area
-Routing Table Area
=510U CPU Unit Area

[ Clear Emor Log
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8.Initialization Method

I 8.2. Initializing the MARS TOHKEN SOLUTION Image Reader

Take the following steps to initialize the MARS TOHKEN SOLUTION Image Reader.

The following steps do not initialize network settings for the Image Reader.

Connect the Interface cable for

1 the Image Leader to the
Personal computer.
2 Perform steps 1 to 13 of 7.2.2.
Parameter Settings.
Set Connection method to Not ~ SCommunication [Advancad options >
3 use in the PLC-LINK Field in Citr| codes corwersion MO
"Communication (Advanced
OptiOﬂS)". Connection method Mot use LAN ‘ R5-232C
(Left half of the PLC-LINK Field)
4 PLC link stops b); clicking the Wirite Settings
Write Settings @ Button. i E—EJR;
S0 G
*Stop PLC link before initializing
the Image Reader whose
Connection method in the
PLC-LINK Field is RS-232C.
5 Click the Read Settings S Read Settings
Button. 0y Ny
$i2 $i2
6 The Read settings Dialog Box is | Readsstings
displayed. Check the contents Read settings
and click the Next Button. +'* Jochch o curent seones f e sconr by
Please make sure to add [Restoration point] if the
HE.E.:I, S
'sztgggs[.Reslurahun point], please select [File] ->
[Restare the settings]
To stard [Read settines] please click [Mext].
Gancel I Naxl(N:)I
7 A message "About Read setting”  { Readsattings

appears in the Read settings
Dialog Box.

Select the Read the default
settings from the scanner and
show on TECT Option.

Click the Next Button.

C About Read setting >

Settines of the scanner can read fram [Setting file]
and [Default settingz] as well as fram the scanner

Please select a task to excute, and click [Next]

" Read the settings from the scanner and show on TECT
" Read the settings from [Setting file] and show on TEGT

| = Read the default ssttings from the scanner and show on TEG T:
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8.Initialization Method

A message "Check the targetto  [rescsemncs TSN
8 read" in the Read | CChock the tarset to resd

rea_ app.ears In the Rea Check the target to rea I

settlngs Dlalog BOX- CheCk the L Please click [Mext] to proceed [Read settings]

contents and click the Next

Button.

Read the default settings from the scanner
and show on TECT

Cancel < BackiB) Finish(E}

9 A message "The settings were Read ssttings
read" appears in the Read | e |
settings Dialog Box. ;
Check the contents and click the
Finish Button.

The settings were read

Cancel | < BackiB) | Hext(M) > I

E - 0 ]
10O Click the Write Settings ﬂ Write Settings——
Button to write the default setting = E-EJ.};
of the Image Reader. LR

11 Click the Save to imager &
Button to save the settings to
non-volatile memory in the
Image Reader.

ﬁ'ﬂ‘\

Save to i

Restart the Image Reader.
12 g

@ Additional Information

Contact the device manufacturer for details on reading/writing settings to the Image Reader
as well as writing data to non-volatile memory.
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9. Revision History

9.Revision History

Revision Date of revision Revision reason and revision page
code
01 Jul. 31, 2014 First edition
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